Buku Ajar Modul 11
Perangkat Lunak Desain VWeb

PENDAHULUAN

A. TUJUAN PEMBELAJARAN

Perkembangan sains dan teknologi menuntut peningkatan kualitas,
pengetahuan dan keterampilan kita dalam berkomunikasi. Sehingga kita
memerlukan suatu teknologi yang dapat memberikan pengetahuan yang lebih
banyak dengan informasi yang mutakhir. Dalam menghadapi perkembangan
teknologi komunikasi, kita dituntut untuk belajar sejak dini agar dapat
berperan secara optimal.

Paket pembelajaran modul 11 ini bertujuan untuk mengenalkan kepada
peserta didik tentang penggunaan perangkat lunak desain web untuk
menghasilkan karya informasi yang sangat dibutuhkan dalam kehidupan
sehari-hari. Setelah peserta didik mempelajari dengan penuh ketekunan dan
mengikuti alur yang ada pada modul 11, diharapkan memiliki bekal
kemampuan tentang penggunaan perangkat lunak desain web sebagai berikut.
1. Mengidentifikasi menu dan ikon pada perangkat lunak desain web.

2. Menjelaskan fungsi menu dan ikon pada perangkat lunak desain web.
3. Menggunakan menu dan ikon pada perangkat lunak desain web.
4. Membuat dokumen desain web sederhana.

Dengan modul 11 ini juga diharapkan peserta didik memiliki cakrawala
pemikiran dan pengetahuan secara umum maupun secara khusus yang
sekarang ini banyak dibutuhkan dalam kehidupan sehari-hari.
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B. STANDAR KOMPETENSI
Membuat Desain Web

C. MATERI POKOK
Perangkat Lunak Desain IWVeb terdiri dari :

1. Identifikasi menu dan ikon pada perangkat lunak desain web

2. Fungsi menu dan ikon pada program desain web

3. Penggunaan menu dan ikon untuk desain web

4. Membuat desain web sederhana
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"l BABI

| ‘J MENU DAN IKON
=TT PADA PERANGKAT LUNAK
DESAIN WEB

ﬁ)mpetensi Dasar :  Mengidentifikasi menu dan ikon pada N

perangkat lunak desain web

Indikator :  Mengidentifikasi menu dan ikon pada :
e Menu Bar
 Standard Toolbar
* Formatting Toolbar
s Views Bar
Menampilkan menu toolbars dari submenu

NI y

A. Pengantar

Microsoft FrontPage adalah sebuah program yang digunakan untuk
membuat, mendesain, dan mengedit halaman web, dengan FrontPage kita
dapat melihat secara langsung apa yang akan tampil di web browser sewaktu
kita mengedit halaman web di FrontPage, dikarenakan FrontPage adalah
sebuah aplikasi yang berprinsip WYSIWYG (What You See Is What You Get)
atau “Apa yang kamu lihat adalah apa yang kamu dapatkan”. Aplikasi
FrontPage dikeluarkan oleh perusahaan piranti lunak (software) terbesar di
dunia yaitu Microsoft. Selain membuat FrontPage, Microsoft juga membuat
aplikasi lain seperti aplikasi pengolah kata Microsoft Word, aplikasi pengolah
angka Microsoft Excel, aplikasi untuk presentasi (Microsoft Powerpoint), dan
sebagainya. Aplikasi-aplikasi tersebut mempunyai susunan, tata letak dan
format yang relatif sama untuk penggunaan menu dan ikon-ikonnya. Materi
yang diberikan dalam bab ini memberikan gambaran tentang tampilan
perangkat lunak desain web khususnya Microsoft FrontPage, sehingga
nantinya siswa dapat mengidentifikasi menu dan ikon yang terdapat pada
perangkat lunak desain web.
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B. Elemen Dasar Perangkat Lunak Microsoft FrontPage

Microsoft FrontPage merupakan sebuah program aplikasi bagian dari
Microsoft Office yang mempunyai kemampuan untuk melakukan desain
web. Microsoft FrontPage memberikan banyak fasilitas untuk melakukan
berbagai macam pengaturan (format) terhadap komponen-komponen web
yang digunakan. Microsoft FrontPage memungkinkan bagi para programer
untuk melakukan editing source program dan menyediakan fasilitas untuk
preview desain web yang dibangun secara mudabh.

Langkah-langkah yang dilakukan untuk menjalankan Microsoft FrontPage :,
pertama kita klik Start > All Programs > Microsoft Office > Microsoft
Office FrontPage 2003 . Secara otomatis akan terbuka sebuah lembar kerja
baru yang masih kosong dengan nama new_page_1.htm. Untuk mengubah
nama dapat dilakukan ketika kita melakukan penyimpanan lembar kerja.
Lembar kerja dengan nama new_page_1.htm akan selalu muncul ketika kita
membuka FrontPage, selanjutnya apabila kita membuka lembar kerja baru
sementara new_page_1.htm masih terbuka maka yang muncul adalah
new_page_2.htm, new_page_3.htm, dan seterusnya.
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Gambar 1. Menjalankan Aplikasi FrontPage

Klik Start
Setelah muncul sejumlah menu, klik All Programs
Klik Microsoft Office

Klik Microsoft Office FrontPage 2003
Jika pada desktop terdapat shortcut Microsoft FrontPage 2003 dapat

langsung melakukan double klik pada shortcut tersebut
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Setelah melakukan langkah di halaman sebelumnya maka akan terbuka lembar
kerja Microsoft FrontPage seperti yang tampak pada gambar di bawah ini.

Title Bar Menu Bar

|

Standard Toolbar

Formatting Toolbar

I

Estimated time to
download

Views Bar

Gambar 2. Elemen Dasar Microsoft FrontPage

Keterangan :

1. Title Bar menampilkan nama file dan lokasi file tersebut.

2. Menu Bar menyediakan menu File sampai dengan Help.

3. Standard dan Formatting Toolbar menyediakan shortcut-shortcut penting
yang akan sangat berguna ketika kita bekerja dengan FrontPage.

4. Page Tab digunakan untuk berpindah halaman ketika kita bekerja
dengan banyak halaman.

5. Views Bar digunakan untuk melihat halaman yang sedang kita kerjakan
pada tipe penglihatan yang berbeda.
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6. Estimated time to download memberikan informasi kepada kita tentang
perkiraan waktu yang dibutuhkan untuk men-download halaman web kita
di browser.

7. Status Bar memberikan macam-macam informasi status pekerjaan yang
sedang kita kerjakan, misal menampilkan tujuan link ketika kursor mouse
kita berada di atas sebuah link.

C. Menu dan Ikon
1. Menu Bar
Menu Bar merupakan baris menu berisi perintah berupa menu-menu
yang aktif dimulai dari menu File sampai dengan Help. Masing-masing
menu mempunyai submenu atau perintah, seperti tampak pada
Gambear 3 dan tabel 1. Berikut ini tampilan perintah menu dan ikonnya.

! Fle Edit View Insert Format Tools Table Data  Frames  Window  Help

Gambar 3. Tampilan Menu Bar

Menu Bar dalam FrontPage terletak dibawah Title Bar, sedangkan
Standard Toolbar dan Formatting Toolbar berada dibawah Menu Bar.
Adapun menu-menu yang tertampil dapat diatur dengan View >
Toolbar, dengan begitu maka menu-menu yang tertampil dapat
dikostumisasi sesuai dengan kebutuhan pengguna.

Di dalam Menu Bar banyak terdapat submenu-submenu yang
berfungsi untuk mengolah halaman web yang kita kerjakan. Submenu-
submenu tersebut adalah menu utama dari FrontPage, karena tampilan
ikon-ikon pada Standard Toolbar merupakan sebagian kecil dari menu
FrontPage yang tersedia. Tujuan dibuatnya bentuk ikon-ikon pada
Standard Toolbar adalah karena menu-menu itulah yang paling sering
dipakai, jadi apabila kita tidak menemukan sebuah menu dalam
bentuk ikon di Standard Tollbar kita dapat mencarinya di Menu Bar.
Berikut ini adalah tampilan submenu-submenu dari Menu Bar :
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Tabel 1. Tampilan Menu, Submenu, dan Ikon pada Menu Bar
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2. Standard Toolbar

Standars Toolbar merupakan kumpulan dari ikon-ikon yang berfungsi

untuk pengolahan layar utama Microsoft FrontPage, misalnya untuk

membuat dokumen baru, membuka dokumen yang telah disimpan,

menyimpan dokumen dan lain-lain. Gambar 4 menunjukkan tampilan

menu ikon untuk Standard Toolbar, dan tabel 2 penjelasan tentang

perintah-perintah untuk masing-masing ikon.
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Secara default tampilan Standard Toolbar adalah sebagai berikut.

BT E:

MisRal= NN AN AN RN = R R A

1o ef

Gambar 4. Tampilan Standard Toolbar

Ikon-ikon yang tertampil di Standard Toolbar dapat diganti sesuai

kebutuhan. Nama perintah ikon dapat kita ketahui dengan cara

mengarahkan pointer mouse pada ikon yang dipilih sehingga akan

tampil nama dari ikon tersebut.

£L.2Format ainter |

= Format Painter

Gambar 5. Tampilan hint Perintah Ikon

Tabel 2. Tampilan Menu dan Ikon pada Standard Toolbar

Ikon Nama Perintah
] New
= Open
= Save
) Find
Publish Site
Toogle Pane
= Print
Loy Preview in Microsoft Internet Explorer 7
4 Spelling
Cut
Copy
Fe Paste
¥4 Format Painter
- Undo
o~ Redo
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3. Formatting Toolbar
Formatting Toolbar adalah kumpulan ikon-ikon yang disediakan oleh
FrontPage untuk memformat halaman web yang sedang dibuat/diedit
sehingga sesuai dengan apa yang diharapkan. Gambar 6 menunjukkan
tampilan menu ikon untuk Formatting Toolbar sedangkan keterangan
masing-masing ikon dapat dilihat pada tabel 3.

: Normal « (default font) = B I U EEE=EE|A 4 |§§g§§;§§;§|.w.é.!

Gambar 6. Tampilan Formatting Toolbar

Tabel 3. Tampilan Menu dan Ikon pada Formatting Toolbar

Ikon Nama Perintah

: Normal - Style
(default font) - Font

3 (12pt) - Font Size
B Bold
I Italic

u Underline

= Align Left
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= Align Center
= Align Right

= Justify
A Increase

A Decrease

iz Numbering

= Bullets
= Decrease Indent
i= Increase Indent
Outside border
b7 Highlight
A Font color

4. Views Bar
Views Bar merupakan kumpulan tombol yang berguna untuk melihat
halaman web yang sedang kita buat dari sisi yang berbeda, misal dari
sisi desain, sisi kode, ataupun keduanya. Gambar 7 menunjukkan
tampilan menu ikon untuk Views Bar sedangkan keterangan masing-
masing ikon dapat dilihat pada tabel 4.

B split El Code “APreview |

Gambar 7. Tampilan Views Bar

Tabel 4. Tampilan Menu dan Ikon pada Views Bar

Ikon Nama Perintah
|3 Desian| Show Design View
| & spiit Show Split View
& Code Show Code View
QU Preview Show Preview View
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M~ BABII

e FUNGSI MENU DAN IKON
“="""  PADA PERANGKAT LUNAK
DESAIN WEB
ﬁ(ompetensi Dasar :  Menjelaskan fungsi menu dan ikon pada \

perangkat lunak desain web

Indikator :  Menjelaskan fungsi menu dan ikon pada:
*  Menu Bar
 Standard Toolbar
» Formatting Toolbar
» Views Bar

\_ J

A. Pengantar
Pada bab II ini akan dibahas fungsi perintah menu dan ikon yang terdapat

pada Microsoft FrontPage. Perintah dan fungsi ikon dan menu adalah sama
meskipun tampilan mereka sangat berbeda. Sebelumnya kita harus
mengetahui apa itu menu atau ikon. Menu adalah bentuk perintah yang
ditampilkan dalam bentuk simbol teks. Pada Microsoft FrontPage, menu-
menu terdiri atas File, Edit, View, Insert, Format, Tools, Table, Data,
Frames, Window, dan Help. Di dalam menu-menu tersebut terdapat
submenu-submenu yang perintahnya sesuai dengan kategori menu. Menu
File berisi perintah yang berhubungan dengan file yang sedang dikerjakan,
menu Edit berisi perintah penyuntingan, menu View berisi perintah
pengaturan layar tampilan, menu Insert berisi perintah intuk menyisipkan,
menu Format berisi perinta untuk pengaturan format dari halaman web
yang sedang dikerjakan, menu Tools berisi kumpulan perintah yang sangat
berguna untuk mengecek kompabilitas halaman web, pengecekan kosakata,
optimasi html dan sebagainya. Menu Table berisi perintah yang
berhubungan dengan tabel, menu Data berisi perintah yang berhubungan
dengan data web, menu Frames berisi perintah untuk bekerja dengan frame,
menu Window berisi perintah untuk membuka window baru, menutup
window dan sebagainya, menu Help berisi perintah untuk bantuan.
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Ikon (Icon) adalah sebuah gambar kecil dalam bentuk simbol yang berisi
perintah tertentu. Tujuan dibuatnya ikon adalah untuk memudahkan
pengguna dalam melakukan perintah atau pengaturan karena ikon ini
berfungsi sebagai shortcut dari perintah-perintah di Menu Bar. Bentuk dari
ikon-ikon tersebut disesuaikan dengan karakter perintahnya, misalnya ikon
untuk perintah menyimpan (save) disimbolkan dalam bentuk disket dan

sebagainya. Penempatan ikon-ikon di

dikostumisasi sesuai keinginan.

B. Fungsi Menu dan Ikon
1. Menu Bar

! Fle Edit View Insert Format Tools

Table

FrontPage dapat diatur dan

Data Frames Window Help

Gambar 8. Tampilan Menu Bar

Menu Bar adalah barisan menu yang menampilkan perintah yang

digunakan untuk mengatur dan mengolah objek. Masing-masing menu

mempunyai submenu dan perintah. Pada modul ini dijelaskan fungsi

submenu-submenu yang sering digunakan dalam perangkat lunak

desain web.

a. Menu File

Menu File berisi submenu dengan beberapa perintah yang

berhubungan dengan pengelolaan file. Menu File terdiri atas hal-hal

yang diuraikan pada tabel 5 berikut ini.

Tabel 5. Fungsi Menu File

Menu dan Ikon

Fungsi Perintah

| | Mew...

Perintah yang digunakan untuk
membuka halaman web baru

Ctrl+0

Perintah yang digunakan untuk
membuka halaman web yang sudah
disimpan sebelumnya

| Close |

Perintah yang digunakan untuk
menutup lembar kerja

N,

Open Site... |

Perintah yang digunakan untuk
membuka site
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Perintah yang digunakan untuk

| Close Site | :
menutup site
| il save Ctl4s | Permt.ah yang digunakan untuk
menyimpan halaman web
Perintah yang digunakan untuk
| Save As... | menyimpan halaman web dengan

nama/ ekstensi yang lain

| @l save Al |

Perintah yang digunakan untuk
menyimpan semua halaman web
yang terbuka

% File Search... |

Perintah yang digunakan untuk
melakukan pencarian berdasarkan
kata kunci (keyword) yang diberikan

Perintah yang digunakan untuk

| Publish Site... |
melakukan publikasi site ke server.
Perintah yang digunakan untuk

| Import. .. | mengimpor suatu file/folder ke
direktori site

| Export... | Perintah yang digunakan untuk

mengekspor site ke suatu direktori

| Preview in Browser » |

Perintah yang digunakan untuk
mencoba halaman web yang sedang
dibuat pada beberapa browser yang
telah ter-install di komputer.

Perintah yang digunakan untuk

| Page Setup... | mengatur property halaman web
ketika mau dicetak
| 4l print o | Perintah yang digunakan untuk
N mencetak (print) halaman web
| i1 send | Perintah yang digunakan untuk
B mengirim pesan via e-mail
Perintah yang digunakan untuk
| Properties | mengatur property halaman web
- seperti title, description, keyword, dan
sebagainya.
Perintah yang digunakan untuk
| Recent Files 3 | melihat/membuka daftar file yang
telah dibuka sebelumnya
Perintah yang digunakan untuk
| Recent Sites [ | melihat/membuka daftar site yang

telah dibuka sebelumnya
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Exit Perintah yang digunakan untuk

menutup aplikasi FrontPage

b. Menu Edit
Menu ini berisi perintah yang berhubungan dengan penyuntingan
halaman web. Menu ini terdiri atas :hal-hal yang diuraikan pada tabel
6 berikut ini.
Tabel 6. Fungsi Menu Edit

Menu dan Ikon Fungsi Perintah

Perintah yang digunakan untuk undo (tidak jadi)
| “} | Undo Typing Cirl+Z | melakukan sesuatu. “Typing” yang tampil pada

gambar akan berubah sesuai keadaan.

Perintah yang digunakan untuk menyalin suatu
| du Cut Ctrl+X | teks atau gambar namun sekaligus menghapus
teks itu di tempat asalnya

2l copy Crl+C | Perintah yang digunakan untuk menyalin (copy)
suatu teks ataupun gambar.

Perintah yang digunakan untuk menampilkan
apa saja yang ada dalam clipboard (suatu tempat

:f?g Office Clipboard... | )
yang digunakan untuk menampung teks atau

gambar yang kita dikopi)

| A paste — | Perintah yang digunakan untuk menempelkan
= teks atau gambar yang telah dikopi

Berisi perintah yang sama dengan Paste namun
| Paste Spedal... | ada pilihan paste tambahan sehingga kita lebih
bisa memilih apa saja yang akan di-paste-kan

Perintah yang digunakan untuk memilih semua
Select All Ctrl+a

yang tampil di lembar kerja

34 End e | Perintah yang digunakan untuk melakukan

pencarian teks di lembar kerja aktif

Perintah yang digunakan untuk melakukan

“ag| Replace... Ctrl+H | pencarian suatu teks kemudian mengganti teks
yang ditemukan dengan teks yang lain

Perintah yang digunakan untuk mengarahkan
|'-'* Go To Bookmark... Ctrl+G | fokus layar ke tempat yang telah di-bookmark
sebelumnya

Perintah yang digunakan untuk membuka quick

| Quick Tag Editor Ctrl+Q | ]
tag editor
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C.

Menu View

Menu ini berisi perintah yang berhubungan dengan pengaturan

tampilan di layer dan pengaturan letak menu-menu dan ikon-ikon

tambahan. Menu View terdiri atas hal-hal yang diuraikan pada tabel

7 berikut ini.

Tabel 7.

Fungsi Menu View

Menu dan Ikon

Fungsi Perintah

] e |

Perintah yang digunakan untuk menampilkan
halaman web aktif di lembar kerja FrontPage

‘ [l Folders ‘

Perintah yang digunakan untuk menampilkan
folder di lembar kerja FrontPage

| 1 Remote Web Site |

Perintah yang digunakan untuk menampilkan
direktori web di server

|..il Reports b |

Perintah yang digunakan untuk menampilkan
berbagai laporan yang berhubungan dengan
website yang sedang dibangun

| f | Mavigation |

Perintah yang digunakan untuk menampilkan
bantuk dari navigasi website yang sedang
dibangun

Perintah yang digunakan untuk menampilkan
bentuk alur tautan (hyperlinks) dari satu halaman
ke halaman lain di website yang sedang dibangun

Perintah yang digunakan untuk menampilkan
daftar “yang harus dikerjakan” (tasks) ketika kita
membangun website, biasanya menu ini muncul
ketika kita memulai membangun website dari
sebuah template FrontPage

Perintah yang digunakan untuk pengaturan
tampilan Ruler dan Grid di lembar kerja FrontPage

f_q Hyperlinks |
| _J-"'_,} Tasks |
| Ruler and Grid » |
| Tracing Image 3 |

Perintah yang digunakan untuk menampilkan
Tracing Image atau gambar yang dijadikan
panduan dalam membuat halaman web

| 5l Folder List  Alt+F1 |

Perintah yang digunakan untuk menampilkan
daftar folder dalam direktori local website yang
sedang dibangun

| }_.,5 Mavigation Pane |

Perintah yang digunakan untuk menampilkan
Navigation Pane di lembar kerja FrontPage

| TaskPane Ctrl+F1 |

Perintah yang digunakan untuk menampilkan
Task Pane di lembar kerja FrontPage
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d. Menu Insert

Menu ini berisi perintah yang berhubungan dengan penyisipan objek

ke halaman web. Menu ini terdiri atas hal-hal yang diuraikan pada

tabel 8 berikut ini.

Tabel 8. Fungsi Menu Insert

Menu dan Ikon

Fungsi Perintah

| Break. ..

Perintah yang digunakan untuk menyisipkan break

| Horizonkal Line

Perintah yang digunakan untuk menyisipkan garis

mendatar
| £ 1 Layer Perintah yang digunakan untuk menyisipkan layer
| — Perintah yang digunakan untuk menyisipkan frame

yang berupa layer

| Date and Time. ..

Perintah yang digunakan untuk menyisipkan tanggal
dan waktu

| Symbal, ..

Perintah yang digunakan untuk menyisipkan simbol

| _d Comment..,

Perintah yang digunakan untuk menyisipkan
komentar

"% web Companent...

Perintah yang digunakan untuk menyisipkan
kompone web yang telah disediakan, seperti marquee,
button, hit counter, dan sebagainya

Perintah yang digunakan untuk menambahkan basis

| Database * |
data
Perintah yang digunakan untuk menambahkan

| Form r | omponen form yang berupa textbox, text area, label,
dan sebagainya

| Pickure » | Perintah yang digunakan untuk menyisipkan gambar

E9 Inkeractive Butkon. ..

Perintah yang digunakan untuk menambahkan
tombol interaktif

Perintah yang digunakan untuk menambahkan file

| File... |
lain
| Bookmark..,  CHIHG | Perintah yang digunakan untuk memberikan
penanda (bookmark)
Perintah yang digunakan untuk membuat link yang
W Hyperlink,..  ChrK |
= e ' terhubung ke file lain

e. Menu Format

Menu ini berisi perintah yang digunakan untuk melakukan

pengaturan atau format objek yang ada di halaman web. Menu Format

terdiri atas hal-hal yang diuraikan pada tabel 9 berikut ini.
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Tabel 9. Fungsi Menu Format
Menu dan Ikon Fungsi Perintah
| A Font... Pengaturan huruf
| =% Paragraph... Pengaturan paragraf

-

-

Bullets and Mumbering. ..

Borders and Shading. ..

| Pemberian nomor atau bullet
| Pengaturan bentuk garis dan model

pewarnaan
P tu isi objek tek

| Position. . | engaturan posisi objek teks maupun
gambar

| Behaviors. .. | Pengaturan behaviors dari halaman web

| 1 Lavers... | Pengaturan layer yang digunakan
Pengaturan format-format tampilan web

| L2 Theme... | ..
yang telah disediakan

| Ad| style... | Pengaturan style dari teks

| Style Sheet Links. . | Pengaturan terhadap file style sheet (CSS)
yang digunakan

| | Page Transition, .. | Pengaturan transisi dari halaman web

| ) Background. .. | Pengaturan background halaman web
Pengaturan terhadap template web yan

| Crynamic Web Template 3 | . & K P P yang
dinamik

| Remove Formatting  Ctrl4+-Shift+2 | Membuang format yang sudah ada

3 P tu ty terhadap objek
| 5 Properties AlEnter | engaturan property terhadap objek yang

terpilih

f. Menu Tools
Menu ini berisi perangkat atau fool yang digunakan untuk

melakukan pengaturan atau format pada halaman web. Menu ini

terdiri atas hal-hal yang diuraikan pada tabel 10 berikut ini.

Tabel 10. Fungsi Menu Tools

Menu dan Ikon

Fungsi Perintah

¥ Speling... F7 Fasilitas pengecekan pengejaan bahasa
Thesaurus., .. Shift+F7 Fasilitas kamus
& Pengaturan kode HTML

Browser Compatibility. ..

Pengaturan kompabilitas browser yang digunakan

Accessibility. F& |
Optimize HTML. .. |

Perintah yang digunakan untuk mengoptimalkan
kode HTML

Macro 3 |

Penambahan, pengubahan maupun penghapusan
macro
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| add-Ins. .. | Kemungkinan untuk penambahan file lain

| Cuskomize. ., | Pengaturan foolbar dan ikon

| Options. ., | Opsi-opsi untuk pengaturan tampilan

| S—— | Sfbsi—opsi yang ada untuk pengaturan halaman

g. Menu Table

Menu ini berisi perintah yang digunakan untuk melakukan

pengaturan terhadap objek tabel yang ada di halaman web. Menu ini

terdiri atas hal-hal yang diuraikan pada tabel 11 berikut ini.

Tabel 11. Fungsi Menu Table

Menu dan Ikon

Fungsi Perintah

i

Layaout Tables and Cells. ..

Perintah yang digunakan untuk melakukan
layout atau pengaturan tabel dan sel

| _-«|? Drraw Table

Perintah yang digunakan untuk menggambar
tabel

| Insert

Perintah yang digunakan untuk menambah tabel,
kolom, baris, sel, dan judul

| I Delete Cells

Perintah yang digunakan untuk menghapus sel

Perintah yang digunakan untuk memilih tabel,

| Select ' | kolom, baris dan sel
| el perge colls | Perintah yang digunakan untuk menggabungkan
= beberapa sel menjadi satu sel
| i sl Cels... | Perintah yang digunakan untuk membagi sel
menjadi beberapa sel
| Split Table | Perintah yang digunakan untuk membagi tabel

71| Table AutoFormat. .,

Perintah yang digunakan untuk mengatur tabel
sesuai dengan format yang telah disediakan

| :E Distribute Raows Evenly

Perintah yang digunakan untuk mengubah
ukuran baris tabel pada ukuran yang sama

| 'jj Distribute Calumns Evenly

Perintah yang digunakan untuk mengubah
ukuran kolom tabel pada ukuran yang sama

Perintah yang digunakan untuk mengubah

Ci4 AutoFit ko Contents | D
ukuran lebar tabel menyesuaikan isi
| p— . | Perintah yang digunakan untuk mengubah
- bentuk tabel ke format teks atau sebaliknya
| Fil 3 | Perintah yang digunakan untuk mengisi data
Perintah yang digunakan untuk mengatur
| Table Properties 3 | property dari tabel, seperti column, row,
background, border, dan sebagainya
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h. Menu Data

j

Menu ini berisi perintah yang digunakan untuk melakukan
pengaturan atau format objek yang ada di halaman web. Menu ini
terdiri atas hal-hal yang diuraikan pada tabel 12 berikut ini.

Tabel 12. Fungsi Menu Data

Menu dan Ikon Fungsi Perintah

i Perintah yang digunakan untuk memasukkan
Insert Daka Yiew. ..
data yang mungkin ada dan digunakan

Menu Frames

Menu ini berisi perintah yang digunakan untuk melakukan
pengaturan objek frame yang ada di halaman web. Menu ini terdiri
atas hal-hal yang diuraikan pada tabel 13 berikut ini.

Tabel 13. Fungsi Menu Frames

Menu dan Ikon Fungsi Perintah

| St Erame | Perintah yang digunakan untuk membagi frame
- menjadi beberapa frame

Perintah yang digunakan untuk menghapus

Sframe

| Delete Frame |

_ _ Perintah yang digunakan untuk membuat
| Cpen Page in Mew Window |
halaman baru

Perintah yang digunakan untuk menyimpan

frame

| Save Page |

Perintah yang digunakan untuk menyimpan
| Save Page As... | . ;
frame dengan nama/ ekstensi yang lain

Perintah yang digunakan untuk mengatur
| Frarne Propetties, .. | property dari frame, seperti name, title, size, dan

sebagainya

Menu Window

Menu ini berisi perintah yang digunakan untuk melakukan
pengaturan window yang ada di halaman web. Menu ini terdiri atas
hal-hal yang diuraikan pada tabel 14 berikut ini.

Tabel 14. Fungsi Menu Window

Menu dan Ikon Fungsi Perintah

Perintah yang digunakan untuk membuat halaman

L3 Mew Window b
web baru

| Open in Mew Window Perintah yang digunakan untuk membuka halaman
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web pada window baru

1 new_page_1.htm * |

Perintah yang digunakan untuk memilih halaman
web dengan nama new_page_1.htm

Close all Pages |

Perintah yang digunakan untuk menutup semua
halaman web yang terbuka

k. Menu Help
Menu Help digunakan sebagai perangkat bantuan pagi pengguna

aplikasi Microsoft FrontPage. Menu ini terdiri atas hal-hal yang

diuraikan pada tabel 15 berikut ini.

Tabel 15. Fungsi Menu Help

Menu dan Ikon

Fungsi Perintah

| ) Microsoft Office FronkPage Help

F1

Perintah yang digunakan untuk
menampilkan bantuan

Shiow the OFfice Assiskant

Perintah yang digunakan untuk
menampilkan asisten office

Microsoft OFfice Online

Sambungan langsung (internet) ke
Microsoft Office

Microsoft FrontPage Developer Resources

Kumpulan dari aplikasi-aplikasi
tambahan dari pembuat Microsoft
FrontPage

Conkack Us

Cara untuk menghubungi pembuat
dari Microsoft FrontPage

Check For Updates

Perintah yang digunakan untuk
melakukan cek terhadap hal-hal
yang bisa di-update

Detect and Repair. ..

Perintah yang digunakan untuk
mendeteksi kerusakan dan
memperbaiki Microsoft FrontPage

Activate Product. ..

Perintah yang digunakan untuk
mengakifkan Microsoft FrontPage

Customer Feedback Options. ..

Umpan balik konsumen pengguna
Microsoft FrontPage

About Microsoft Office FrontPage

Segala sesuatu tentang Microsoft
FrontPage

B. Standard Toolbar
Standard Toolbar merupakan kumpulan ikon yang berfungsi untuk

pengolahan layar utama Microsoft FrontPage, misalnya untuk membuat

dokumen baru, membuka dokumen yang telah disimpan, menyimpan

dokumen dan lain-lain.
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Tabel 16. Fungsi Ikon pada Standard Toolbar

Ikon Nama Perintah Keterangan
B New Membuat dokumen baru
=3 Open Membuka dokumen
= Save Menyimpan dokumen
3 Find Mencari kata
Publish Site Memasang hasil desain web di internet
= Print Mencetak dokumen
< Preview Melihat hasil desain web
e Spelling Cek spelling kata
Cut Memotong objek
Copy Menyalin objek
[Fe Paste Meletakkan data hasil menyalin
¥ Format Painter Pengaturan alat warna
S Undo Kembali ke kondisi sebelumnya
(u Redo Menuju kondisi berikutnya
(e Web Component Komponen dari web
= Insert Table Menyisipkan tabel
1 Insert layer Menyisipkan layer
B Insert Picture From | Menyisipkan gambar dari file yang
File tersimpan
4 Drawing Menggambar
=N Insert Hyperlink Menyisipkan hyperlink (pertautan
halaman)
i Refresh Menampilkan ulang
Stop Menghentikan proses
q Show All Menampilkan semua format
L Show Layer Anchors | Menampilkan petunjuk layer
(7] Microsoft Office Bantuan informasi
FrontPage Help
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C. Formatting Toolbar
Formatting Toolbar adalah kumpulan ikon yang disediakan oleh
FrontPage untuk memformat halaman web yang sedang dibuat/diedit
sehingga sesuai dengan apa yang diharapkan.

Tabel 17. Fungsi Ikon pada Formatting Toolbar

Ikon Nama Perintah Keterangan
£ Normal - Style Jenis style
(default font) ~ | Font Jenis huruf
3 (12pt) = Font Size Ukuran huruf
B Bold Menebalkan teks/huruf
I Italic Membentuk miring
teks/huruf
Underline Memberi garis bawah
teks/huruf
= Align Left Meratakirikan objek
= Align Center Meratatengahkan objek
= Align Right Meratakanankan objek
= Justify Merata kanan-kiri objek
A Increase Memperbesar huruf
A Decrease Memperkecil huruf
i= Numbering Memberi penomoran
= Bullets Memberi bullet
i= Decrease Indent | Mengurangi paragraf
is Increase Indent | Menambah paragraf
Outside border Membuat garis pada tabel
A Font color Merubah warna huruf
D. Views Bar

Views Bar merupakan kumpulan tombol yang berguna untuk melihat
halaman web yang sedang kita buat dari sisi yang berbeda, misal dari
sisi desain, sisi kode, ataupun keduanya.
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Tabel 18. Fungsi Ikon pada Views Bar

Ikon Nama Perintah Keterangan
Show Design View Melihat tampilan desain
|EI Split Show Split View Tampilan dibagi menjadi 2
(desain dan kode)
& Code Show Code View Melihat tampilan kode
program
QUPreview Show Preview View Melihat hasil desain web
dalam browser internal
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M~ BABIII

e PENGGUNAAN MENU DAN IKON
=" PADA PERANGKAT LUNAK
DESAIN WEB
KKompetensi Dasar :  Menggunakan menu dan ikon pokok pada \

perangkat lunak desain web

Indikator :  Menggunakan menu dan ikon pada :
* Menu Bar
» Standard Toolbar
* Formatting Toolbar

» Views Bar
\_ /

A. Pengantar

Pada materi ini akan dijelaskan bagaimana cara menggunakan menu dan
ikon pada perangkat lunak desain web. Perlu diketahui bahwa
pengembangan software selalu menciptakan inovasi-inovasi baru dalam
menampilkan sebuah tampilan, khususnya tampilan menu dan ikon. Hal
ini bertujuan untuk memudahkan si pengguna menjalankan perintah yang
dimiliki oleh program tersebut. Oleh sebab itu, materi yang diberikan
berupa cara bagaimana menggunakan menu dan ikon dengan pendekatan
fungsi alat (yaitu fungsi mouse dan fungsi keyboard).

B. Penggunaan Menu dan Ikon
1. Penggunaan Menu Bar
Penggunaan menu pada Menu Bar dapat menggunakan 2 (dua) cara,
yaitu menggunakan mouse dan menggunakan fungsi tombol keyboard.
a. Menggunakan Mouse.
1) Arahkan pointer mouse pada salah satu Menu Bar.
Sebagai contoh arahkan pointer mouse pada menu File
2) Klik menu File, maka akan muncul sub menu File berisi perintah-
perintah pengelolaan file.
3) Klik salah satu perintah yang diinginkan.
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Sebagai contoh klik submenu perintah New, maka perintah yang
dilakukan adalah membuat dokumen baru
4) Lakukan hal yang sama untuk menu yang lain.
b. Menggunakan fungsi tombol keyboard :
1) Menggunakan fungsi tombol Alt
Jika kita melihat Menu Bar, terlihat pada setiap menu terdapat
huruf yang bergaris bawah, untuk melaksanakan perintah
tersebut dapat menggunakan fungsi tombol Alt, sebagai contoh
menu File, maka huruf F yang bergaris bawah dan untuk
melakukan perintahnya adalah sebagai berikut.
a) Tekan tombol Alt (tidak dilepas) pada keyboard dan tombol
huruf F secara bersamaan.
b) Tekan tombol huruf yang bergaris bawah pada submenu
perintah.
c) Sebagai contoh perintah New maka yang ditekan tombol huruf
N.
d) Maka perintah yang dilakukan adalah membuat dokumen
baru.
e) Lakukan hal yang sama untuk menu yang lain.
2) Menggunakan fungsi tombol Ctrl
Penggunaan menu fungsi tombol Ctrl pada dasarnya hampir
sama dengan menggunakan fungsi tombol Alt, akan tetapi tidak
semua menu dapat menggunakan fungsi tombol Ctrl. Berikut ini
beberapa contoh menu perintah yang dapat menggunakan fungsi

tombol Ctrl :
Tabel 19. Fungsi Tombol Ctrl
Fungsi Ctrl Fungsi Perintah

Ctrl +N Membuat lembar kerja baru

Ctrl +O Membuka lembar kerja baru

Ctrl +S Menyimpan lembar kerja

Ctrl +P Mencetak lembar kerja
Kembali ke kondisi

Ctrl +Z
sebelumnya

Ctrl +Y Menuju ke kondisi berikutnya

Ctrl +X Memotong objek

Ctrl +C Menyalin objek

Ctrl +V Meletakkan hasil salinan objek
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Fungsi tombol Ctrl dapat dilihat pada tampilan submenu disetiap
Menu Bar.
Perhatikan tampilan submenu pada menu File berikut:

Microsoft FrontPage - new_page_1.htm
! Fle Edit View Insert Format Tools Table Dats Frames Window Help Type -
{3 New... el Pls amglo- o EANES8 10 0L el
{5 Open..  CHIHO =t 3 (200 GEERERIN IS s = e s e S e
f giuse X} Getting Started X
*5 Opensite... @A
skt o [l e :
H sve  crlss 2 0ffice Online
Sl Connect to Microsoft Office
\j Save Al Online
aa Get the latest news about using
) File Search. .. FrontPage
Publish Site Automatically update this list
i from the web
Import... e
Eoort Search for:
e it S
Page Setup... Example: Print more than one copy™
4| Print Preview Open =
4| Print..  Ctl+p e
4 My Web Sites
&
| &5 more...
4 Pages
(5 Open...
Recent Sites »
Exit _] Create a new page or site...
ESpht ECode QPreview ‘
0:01@56Kbps | 727 x 437  Default | Custom

' Perintah Menu yang menggunakan
fungsi tombol Ctrl

Gambar 9. Fungsi Tombol Ctrl pada Menu Bar

3) Penggunaan Perintah Ikon
Untuk dapat menggunakan perintah ikon vyaitu dengan
melakukan cara sebagai berikut.
a) Arahkan pointer mouse pada ikon perintah.

b) Sebagai contoh arahkan pointer mouse pada ikon h pada
Standard Toolbar.

c) Lakukan klik menggunakan tombol mouse sebelah kiri.

d) Maka perintah yang dilakukan adalah membuat dokumen
baru.

2. Penggunaan Ikon pada Standard Toolbar
Untuk dapat menggunakan perintah ikon pada Standard Toolbar yaitu
dengan melakukan cara sebagai berikut.
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a. Arahkan pointer mouse pada ikon Standard Toolbar.

Sebagai contoh arahkan pointer mouse pada ikon B pada Standard
Toolbar.

b. Lakukan klik menggunakan tombol mouse sebelah kiri.

c. Maka perintah yang dilakukan adalah membuat lembar kerja baru.

3. Penggunaan lkon pada Formatting Toolbar
Untuk dapat menggunakan perintah ikon pada Formatting Toolbar yaitu
dengan melakukan cara sebagai berikut :
a. Blok terlebih dahulu kata atau kalimat yang akan diformat.
b. Arahkan pointer mouse pada ikon perintah.

Sebagai contoh arahkan pointer mouse pada ikon B pada Formatting
Toolbar

c. Lakukan klik menggunakan tombol mouse sebelah kiri.

d. Maka perintah yang dilakukan adalah untuk menebalkan kata/huruf
yang diblok tadi.

4. Penggunaan Ikon pada Views Bar
Untuk dapat menggunakan perintah ikon pada Views Bar yaitu dengan
melakukan cara sebagai berikut :
a. Arahkan pointer mouse pada ikon Views Bar.

Sebagai contoh arahkan pointer mouse pada ikon “Preview nada Views
Bar.

b. Lakukan klik menggunakan tombol mouse sebelah kiri.

c. Maka perintah yang dilakukan adalah menampilkan hasil tampilan
desain web pada browser internal Microsoft frontPage.
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M BABIV

[ n J MEMBUAT

“=""" DESAIN WEB
SEDERHANA
Ampetensi Dasar :  Membuat desain web sederhana \
Indikator : + Memulai Mengoperasikan Microsoft

FrontPage
* Membuat Site Baru
*  Membuat Home Page
*  Membuat CSS (Cascading Style Sheet)
* Mengintegrasikan Style Sheet
* Menambahkan Format
* Mengubah Ukuran Huruf
* Mengubah Ketebalan Huruf
* Perataan Teks (Align Text)
* Indent Text
* Membuat List (Daftar)
*  Membuat Link ke Halaman Baru
*  Membuat Link Antar Halaman

\\ ¢ Memasukkan Gambar /

A. Pengantar

Pada bab sebelumnya kita belajar mengenai kegunaan menu-menu dan
ikon-ikon di Microsoft FrontPage, maka di bab ini akan dijelaskan bagaimana
membuat sebuah website sederhana. Penjelasan pada bab ini berbasis
gambar sehingga memudahkan bagi yang mempelajarinya.
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B. Memulai Mengoperasikan Microsoft FrontPage 2003

(L) Shortcut to Start Menu
@ Set Program Access and Defaults
A0 wWindows Catalog
‘ Windows Update
CD winzip
@ Accessories
@ ACD Systems
@ Adobe
@ Borland Delphi 7
(@) Canon PIXMA PLOOD
[T CorelDRAW Graphics Suke 12
@ Download Accelerator
@) DU Meter
@ Electronics Workbench
) Eset
@i oo
) ] (@) Globalscare
@ fn_ucn:oas'olft office outlf] 73 Intel PROSE Wireless

@) 7 Bluesolei

Microsoft Office Fror
Ci? 2003 @ Macromedia

j > Microsoft
Adobe Photoshop C3
@ Microsaft Yisual Basic 6.0

@ Microsaft Web Publishing

El HyperSnap &
Mozilla Firefox
|Tm Microsoft Office War @ Multimedia

@ Mero
B Notepad @ Mew Wisio Drawing
e @ Morton PartitionMagic 8.0
Q 1-Click. Mainkenance
@ Starkup
@ TransTool

é Internet Explorer
& Java Plug-in Control Panel
WY M5 Explarer

ﬂ Opera

@ Outlook Express

h Remote Assiskance
. Wisio Technical
&) windows Madia Player

3 Windows Messenger
@ Cheating-Death
7 Counter-Strike 1.6

@ Microsoft: Office Tools
Microsaft Office Access 2003
Microsaft Office Excel 2003
E i romkP:
Microsaft OFfice InfoPath 2003
Micrasoft Office Qutloak 2003
Microsoft Office PowerPoint 2003
Microsaft Office Publisher 2003
[ Microsoft Office word 2003

Create and manage Web sites that logk and work exactly the
way vou want by using Microsoft Offide FrantPage.

i All Programs | ) Tunellp Uilities 2006
) winRaR
@ winzip
< @ ahoo! Messenger
A
— Klik Start

Ol L=

Gambar 10. Menjalankan Aplikasi FrontPage

Setelah muncul sejumlah menu, klik All Programs
Klik Microsoft Office

Klik Microsoft Office FrontPage 2003
Jika pada desktop terdapat shortcut Microsoft FrontPage 2003 dapat

langsung melakukan double klik pada shortcut tersebut
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C. Membuat Site Baru

1. Setelah FrontPage 2003 terbuka, akan muncul tampilan seperti di bawah
ini.

[El Microsoft FrontPage - new_page_1.htm

i Fle Edit View Insert Format Tools Table Data Frames Window Help Type a question for help [+

RET=TR= N NN PAN o AR N G A R AL R R i AL NREN AR, RGN

iNormal - Times New Roman -3 - B L U|EEE=E=|A 4SS E :_E|-=P.7-é-!

JneWJageil.htm x Gettngsmrted * X
<body> @|@ | & 1

\ 12 &ffice Online

.

Connect to Microsoft Office
Online

Get the latest news about using
FrontPage

Automatically update this list
from the web

-

.

Search for:
]
Example: “Print more than one copy™
Open .
Web Sites

mysite2

My Web Sites
Mare...

Pages
panduan-memelihara-account-go
index.htm

Lj More...

] Create a new page or site...

B spiit B Code G Preview |

0:01@56Kbps 697 x 512 Default  Custom

Gambar 11. Lembar Kerja Microsoft FrontPage

2. TPada Menu Bar, klik File > New

[E] Microsoft FrontPage - ne

{| Bile | Edit View Insert Fo
0 wen ]
lj pet... Ctrlfﬁt] omar
. Close —

Gambar 12. Memilih Submeu New pada Menu File
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3. Pada Tasks Pane klik One page WVeb site...

New page

|_] Blank page

2] Textfie

Eﬂ From existing page...

More page templates...

|§3 Web package solutions. ..
More Web site templates. ..

Temnplates

Gambar 13. Membuat Web Satu Halaman

4. Ketika window Web Site Templates muncul, select (klik sekali) One Page

Web Site seperti pada gambar di bawah ini.

Web Site Templates

General | Packages || SharePoint Services |

TS @3 A |2
One F'EgN‘NEl:I gorporate Customer Support Options
Site Esence Wizard Web Site Spedfy the location of the new Web site:
————
|F:1|||'«"I11-I Docs'My Web Sitesmysite3 | w |
N & g
Database Discussion Web  Empty Web Site i e
Interface Wizard Site Wizard a : : -
== Description
EI I EI I Create a new Web site with a single
blank page.
Import Web Site  Personal Web Site Project Web Site
Wizard
SharePoint Team v
[ OK ] [ Cancel
Gambar 14. Memilih Template
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5. Kemudian klik Browse.

Web Site Templates

General |Pad<ages || SharePaint Services |

= = o |-
g g §=F
One Page Web Corporate Customer Support Options
Site Presence Wizard Web Site Specify the location of the new Web site:

W Sites\mysite3 v |

N g g

Database Discussion Web  Empty Weh Site
Interface Wizard Site Wizard

F= Description
@ I @ I Create a new Web site with a single
blank page.
Import Web Site Personal Web Site Project Web Site
Wizard
SharePoint Team v
I Ok l [ Cancel

Gambar 15. Memilih Tempat Penyimpanan File 1VVeb

6. Akan muncul window baru seperti pada gambar berikut, kemudian klik

My Documents.
New Web Site Location El
Lok in: |[ﬁ Didik Hariyanto's Docurnents v @ -3 '& X O [ - Tooks -
My Recent
Docurnents My Wb Sites
?I-—-_. /-5 MySetups
Deskkop
d x

B

-~

My Documents
I — "

=

My Computer

-

Sike name: | w | [

My Mekwark,

Places Cancel

Gambar 16. Memilih Tempat Penyimpanan File IVeb
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7. Setelah masuk ke My Documents, klik ikon New Folder untuk membuat
folder baru di dalam My Documents.

Mew Weh Site Location

| () Didik Harivanto's Documents
(CxBluetooth;
)y music
My Recent | |i2)py pictures
Documents || [@my web Sites
?-[—-_- |y MySetups
Desktop
My Dacuments
My Computer
l@ g Site narme: w o
it Open
Iy Metwork, | [ ]

Gambar 17. Membuat Folder Baru
8. Selanjutnya muncul window New Folder, lalu masukkan nama untuk
folder baru, misalnya “Sekolahku” (jika website yang akan dibuat
bertemakan sekolah). Kemudian klik tombol OK untuk melanjutkan.

Mew Folder

|Sekolahkul

Gambar 18. Memberi Nama Folder Baru
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9. Setelah folder “Sekolahku” terbuka klik Open.

New Web Site Location
Look in: |B Sekolahku

My Recent
Documents

Desktop

v| @ @@ X Ci 1 Took~

g
Y
My Documents
oy
My Computer
o =)
[ Site =
My Metwark e | ‘{[ I Oeen l >
Places Canckl
—

Gambar 19. Membuka Folder “Sekolahku”

10. Kemudian klik OK di window Web SiteTemplates.

Web Site Templates

General | Packages || SharePoint Services |

g & o] 8 (%)
One Page Web Corporate  Customer Support Options
Site Presence Wizard Web Site Spedfy the location of the new Web site:
|F:1|||'«"I11-I Docs\Sekalahkul w

S g g

Database Discussion Web  Empty Web Site o
Interface Wizard Site Wizard A

Description

@ @I I @I I Create a new Web site with a single
blank page.
Import Web Site  Personal Web Site Project Web Site
Wizard

7] !

SharePoint Team

|4

N

C i =N
oK |
) L
Gambar 20. Menekan Tombol OK untuk MeW
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11. Setelah itu double klik pada index.htm seperti pada gambar berikut ini.

[E] Microsoft FrontPage - F:\My Docs\Sekolahku
I Ale Edit View Insert Format Tools Table Data Frames Window Help Type a question for help [+
ECES o H B3 P e P B EWNR IRCY |
] | | s Y |
[ial web site
Contents of 'F: My Docs\Sekolahku' LDt
Name Title: Size | Type Modified Date Modified By Comments
_private
(Chimages
{atindexchtm | indix.htm KB him 1/26/2008 11:24AM  ACER\Cahya
kg
< 2
[EoFolders | & Remote Web site B Reports deMavigation B Hyperlinks & Tasks
Default  Custom

Gambar 21. Double Klik pada index.htm

12. Akan muncul tab index.htm.

[El Microsoft FrontPage - F:\My Docs\Sekolahkulindex. htm
! Fle Edit View Insert Format Tools Table Data Frames Window Help Type a question forhelp |+
HARN=EN" F: - 01BN N A N - S A el AP 438 09 Jal@!
iNorma%W S3(2p) - | B I U= | A &= s ?||§|va£vvé.!
indexhtm™ ) x
BT 4
|[B0esion| Espit B code Qpreview |
IF:\MyDoG\Sako\ath\index.ht:rn 0:01@56Kbps 903 x 512 Default  Custom
Gambear 22. Halaman index.htm Sudah Tebuka
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13. Untuk lebih memudahkan, pada Menu Bar klik View > Folder list

1=

& g ko (0 §¢ U Jis]

[n=l
o

['=]

m

Folders

Remote Web Site
Reports
Mavigation
Hyperlinks

Tasks

Ruler and Grid

Tracing Image

iew | Insert Format Toc

3

Fliger st Alt+F1

2 [ |

Mavigation Pane

Task Pane Ctrl+F1

Toolbars

Refresh F5

¥

Gambar 23. Submenu Folder List pada Menu File

D. Membuat Home Page

1. Pada halaman yang kosong seperti pada gambar ketik “Home page

Sekolahku”.

|l Web site || index.htm®

<body=

Home page Sckolahku

Gambar 24. Pengisian Tulisan pada Halaman Veb
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Ingatlah nama halaman ini yaitu index.htm, ini adalah home page dari
website “Sekolahku”.

Home page dari setiap website bernama index.htm
atau index.html

Hal ini dikarenakan index.htm atau index.html
tersebut muncul secara otomatis setiap kali sebuah
alamat website dibuka di browser.

Jika kita membuka www.sekolahku.com yang
muncul adalah halaman home page karena file home
page bernama index.htm

Jika file Home page bernama selain index.htm
misalnya homepage.htm maka untuk membuka
halaman home page kita harus mengetikkan alamat
www.sekolahku.com/homepage.htm

2. Klik kanan pada bagian kosong di halaman web yang sedang kita buat,
kemudian klik Page Properties.

|| Web Site || index.htm®
<body =

Home page Sekolahkn

[ Paste

Open Pag; g Mew Window

O
74 Manage Editable Regions...
| Page Properties... % >

1'_!5, Hyperlink. ..

Gambar 25. Melakukan Pengaturan Halaman
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3. Sesudah window Page Properties muncul, pada tab General > Title, ketik

“Home page Sekolahku” seperti pada gambar di bawah ini. Klik tombol
OK untuk melanjutkan.

Page Properties

General |Forrnath'ng || Advanced || Custom || Language || Workgroup |

EXT)/F: My Docs/Sersalgkuy/index. htm |

|Hor|1e page Sekolahku] ) |

~———

Location:

Tite:

Page description:

Keywords:

Base location: | |

Default target frame: | | ﬂ

Background sound

Location:

| | Browse...
Loop: I:l Forever

( N\
[ 0K, ] [ ) Cancel ]

Gambar 26. Pengisian Property Title

Title dari sebuah halaman web adalah apa yang
tertampil di sebelah pojok kiri atas dari browser

Title

/> Home page Sekolahku - Windows Internet

e —

"E F:\My Docs\Sekolahlkuinde:x. htm

GO |
o, e

w o dhr [@Hame page Sekolahky < Title

Gambar 27. Tulisan Title pada Browser
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4. Simpan halaman web dengan cara mengklik ikon Save.

Microsoft FrontPage - F:\My Docs\Sel

! File TEW 1
B EREEN =TS
ENormalwgﬁ%man &l -
Folder List JEa x

t Format Tools

) F:\My Docs\Sekolahku <hod
= -<p:>
I _private —-
| images
{z index.htm Home page §

Gambar 28. Melakukan Penyimpanan

+ Kita telah membuat sebuah home page dari website “Sekolahku”
* Nama file home page adalah index.htm
» Terletak di folder Sekolahku di My Documents

E. Membuat CSS (Cascading Style Sheet)
Cascading Style Sheet merupakan suatu bentuk fasilitas yang tersedia dia
Microsoft FrontPage yang berguna untuk melakukan format berbagai objek
yang digunakan dalam desain web. Langkah yang dilakukan dijelaskan
sebagai berikut.

1. Pada Menu Bar klik File > New

Microsoft FrontPage - F:\My
!l File | Edit Wiew Imsert Format

10 mew. [
ﬁ e Ctlrﬁ{l joman

Close

Gambar 29. Memilih Submeu New pada Menu File
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2. Kemudian klik More page templates.

New page

|_] Blank page
2] Textfile
ZAAPTEm existing page.

e tempplates. ..

Maore

etnllieb site
@l One page Web site...
IQ‘:J SharePoint team site. ..
EH weh nackane solitions. .

Gambear 30. Memilih Template Halaman

3. Setelah window Page Templates muncul, klik tab Style Sheets.

Page Templates

| General || Frames ﬁges | Style Shﬁtﬂ |
\ /J .
o
g e
Style Arcs Bars Options
[ 3ust add web task
Description
@{ ] @{ ] Create a blank cascading style sheet,
Blueprint Capsules
Preview
=] I =] I =] I . .
Dowritown Expedition Highway
g 9 9
MNeon Poetic Street ~
[ CK ] [ Cancel

Gambar 31. Memilih Style Sheet
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4. Double klik pada ikon Normal Style Sheet.

| General || Frames Pages | Style Sheets |

Blocks

=

Downtown

2

Meon

Blueprint

&

Expedition

&

Poetic

G

&

Capsules

&

Highway

&

Street

| €

Options
[]3ust add web task

Description
Create a blank cascading style sheet.

Preview

[ OK, l [ Cancel

Gambear 32. Memilih Normal Style Sheet

Sebuah Style Sheet kosong akan terbuka.

—_—

-

[ Web Site ” indm{.h&n \{ new_page_1l.css

Gambar 33. Style Sheet Baru telah Terbuka

5. Pada Menu Bar, klik Format > Style.

|| =

Format | Tools Table Data F

Font...
Paragraph...
Bullets and Numbering. ..

Behaviors. ..

Lavyers...

Theme...

(N ITRN:

Style...

S

Style Sheet Links. ..
Dynamic Web Template

el
e

3

Gambar 34. Memilih Submenu Style pada Menu Format
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6. Setelah window Stile muncul, klik h1.

Styles: Paragraph preview
asactive A P rim Pa
a:hover — Fezvea P
a:link ) ) ]
a:visted e e ket e e e
a Medzied
address
body
Character preview
| bt e ——
fieldzet
._hz ) amevyoany
h4
h5 Description
hé | Click Modify to create a style for the currently
br = selected HTML tag.
s Click Mew to create a new custom style,
HTML tags v |

[ Mew... ][ Modify... ] Delete

[ OK ] [ Cancel

Gambar 35. Memilih Style h1

untuk melanjutkan.

Styles: Paragraph preview
aactve LS
ahower —
alink . _ _
a:visited e S et e e et e
a M edafed
address
body
button || - Character preview
fieldset
[ :
. AaBbYyGeLllj _
h3
h4
h5 Description
hé | ClideModify to create a style for the currently
hr | selected HTML tag.
lizk: Click Mew to create a new custom style.
HTML tags v |
[ Ok ] l Cancel

Gambear 36. Klik Tombol Modify untuk Melanjutkan
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8. Pada window Modify Style klik Format > Font.

Styles; »

— Modify Style

:EIT:: Mame (selector]: Style type:

a:visit |h1 | Paragraph |

a

addre

body

butto

fieldsd Preview

h2 ;5 & o viua Pamgmph Provim -

h3 -

h4 Famgmph Brigg Modifed Famgeph Boig Med #iod Pxagaph Boig Modifnd

h5 Famgmph Beimg Medfed Famgeph Bong Med Sxd

h& kwing Famgspl lewig Pamgap

hr

Description

List:

HTML

—""_

( Format ¥\ [ oK ] [ Cancel ]
o [ Ok l [ Cancel ]
order...

Mumbering. ..
Pasitior...

Gambar 37. Melakukan Format Font

9. Pada window Font, klik Verdana iada daftar Font.

Font | Character Spacing |
Font: Font style: Size:
p
< Tw Cen MT Condensed Extra Bold 10px -~
L “sin £
b Webdings e 2mm .
IO == lem
Wingdings 2 || |BoldItalic ~| |8pt b
Color: | ] Automatic A4 |
Effects
[ underline [ small caps
[ strikethrough [ Al caps
[ overline [ capitalize
[ Blink [Hidden
[IMo text decoration
Preview
I AaBbYyGgLllj |
[ QK ] [ Cancel ]

Gambar 38. Memilih Huruf dengan Jenis Verdana
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10. Dibawah Font Style, klik Bold, kemudian klik tombol OK wuntuk

melanjutkan.
Font B
Font | Character Spadng |
Faont: Font style: Size:
Verdana jold
Tw Cen MT Condensed Extra Bold A || |MNormal A 10px -
\ierdana » ‘H—\_ .5in 1
Webdings Oblique 2mm =
Wingdings — = 1em
Wingdings 2 * || |Bold Ital b apt b
S e

Color: | [] automatic v |
Effects

[Junderline []small caps

[ strikethrough [ Al caps

overline [ capitalize

[ Blink [Hidden

[INo text decoration
Preview

D AaBbYyGgllJj |

~
[ oK ] ’) Cancel ]
=

Gambar 39. Memilih Bold untuk Menebalkan Huruf

11. Klik OK pada window Modify Style.

Style X
Styles;
ify Style
p— Modify Style
:EIT:: Mame (selector): Style type:
a:visit |h1 | |?.='E;'E:- |
a
addrg
body
buttol
fieldsq Preview
h2 = rgh Pec Ny - _
h3 -
h4 £irsarieh Saby Meatied Carmwesh Sehe Meand
hE Faragraph Ecing Modifled
hi F ol wing Famgeagph Folb wing Famgmpk Folbwing Famgepk Folbwing Famgeph
hr
Description
List:
font-family: Verdana; font-weight: bold
HTML
R P I
\ :
Format ¥ | 0 Cancel .
Ql

[

Gambar 40. Klik Tombol OK untuk Melanjutkan

K l [ Canicel
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12. Klik OK pada window Style.

X

]

]

Style
Styles: Paragraph preview
Faragraph B2ing Modified Paragraph Ezing
ModHiked Paragraph BEzing Modfied
Faragraph BEzing Modified Faragraph Ezing
ModHikd
Character preview
_  AaBbYyGgLly __
Description
font-family: Verdana; font-weight: bold
List:
User-defined styles w |
[ Mew... ] [ Modify. .. ] ’ Delete
[ (04 RJ l) Cancel
4

Gambar 41. Klik tombol OK untuk Melanjutkan

13. Klik ikon Save pada Standard Toolbar.

[&] Microsoft FrontPage - new_page 1.css

! Fle Edit View Insert Format Tools Table Data  Frame:
YR -t A
TN & 7

[ Sl - - B LU

Folder List 00 x [Ii Web Site ” index.htm-\l new_pag
|5) F:\My Docs\Sekolahku hi [ font-famil
) _private

Gambar 42. Klik Ikon Save untuk Menyimpan
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14. Selanjutnya kan muncul window Save As, masukkan nama format.css

kemudian klik Save.

Save As @
Save in: | Sekolahku

A =) _private
& [Cimages

My Recent | ||&]index.him
Documents

Desktop

V| ] Lﬁ|'&>‘< =i B - Tools -

i,
My Documents
My Computer
Page title: Change title...

i | I Sawve

File name: |Format.css

My Metwork
Places Save as type: |WEb Pages (*.htm;* html; *.shtml; *, shtm; * stm; *.asp; *.: |

Gambar 43. Klik Tombol Save untuk Menyimpan

15. Tampilan akan menjadi seperti gambar berikut.
-|| || BL U= = | e i

V4
[Ii Web Site ” indﬂ.htﬁw
hl [ font= v: Verdana; font-weight: bold 1

Gambar 44. Tampilan Hasil format.css

il
14
"I

F. Mengintegrasikan Style Sheet
1. Klik tab index.htm

&l Web 5ite | index.htm%format.css\
<body =

Home page Sekolahin

Gambar 45. Tampilan tab index.htm
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2. Pada Menu Bar klik Format > Style Sheet Links.

Format | Tools Table Data F

Font...

=

Paraaraph...

o
1=l

Bullets and Mumbering. ..

Behaviors. ..

Layers...

RN

Theme...
& feran

Style Sheet Links... >

C

»
W

Gambar 46. Pemilihan Style Sheet Links

3. Pada window Link Style Sheet pilih All pages kemudian klik Add...

Link Style Sheet

URL: Q Add... >

[ Ok ] [ Cancel

Gambar 47. Pemilihan All pages
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4. Pada window Select Style Sheet pilih format.css. Klik tombol OK untuk
melanjutkan.

Select Style Sheet

Look in: | F:\My Docs\Sekolahku w 5
Mame Title
[ﬁ _private

< : @ format.css

A |

URL: |format.css v| g ﬂ
Ok Cancel

Gambear 48. Memilih format.css yang sudah dibuat

5. Pada window Link Style Sheet klik OK.

Link Style Sheet

(%) All pages

(") Selected page(s)
URL: Add
format.css

Remove

— oD |

Gambar 49. Klik Tombol OK untuk Melanjutkan
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6. Ketika ada pesan konfirmasi pilih Continue.

a3 fata

'T This operation will overwrite all of the selected pages' stylesheet links. Do you wish to continue?
L

[ Contjnue ] Baminestﬂe SheetLinksReport] [ Cancel ]

Gambar 50. Klik Tombol Continue untuk Melanjutkan

G. Menambahkan Format
1. Klik pada kalimat “Home page Sekolahku” untuk menempatkan cursor
di baris yang sama dengan kalimat.

es Mew Roman * 3 (12pt) v| B 7 U |§

[ = ||| web site index.htm\kformat.css
ahku <body =

@e padem@

Gambar 51. Menempatkan cursor pada Kalimat

Klik dropdown list seperti pada gambar berikut ini.

[ Normal Tin)es Mew Raor

T Bulleted List _[
[f] 8 Default Character Style
1 Defined Term

1 Definition

1T Directory List

T Formatted

1 Heading 1

T Heading 2

1 Heading 3

1 Heading 4

1 Heading 5

1 Heading 6

1 Menu List

1 Mumbered List

Gambar 52. Menampilkan dropdown list
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2. Pada menu pilih Heading 1.

i Normal = [ Times Mew F

T Address
T Bulleted List
| @ Default Character Style
T Defined Term
T Definition
T D )

Formatted

T Heading 2

T Heading 4

T Heading 5

T Heading &

T Menu List

T Mormal

T Mumbered List

Gambar 53. Memilih heading 1 pada dropdown list

3. Setelah itu tampilan akan seperti pada gambar berikut ini.

iHeading1 = Verdana - 6 (24pt) | I U|E=Z==|A 4 = iS i
Folder List J 3 X ||[G web site index.htm*\kformat.css
) F:\My Docs\Sekolahku bod hi
) _private o
|[Z) images
=
7 et Home page Sekolahku
{4 indes.htm
Gambar 54. Tampilan Hasil Format
4. Pada toolbar klik ikon Save.
R |
Folder List Jd 0 x
) F:\My Docs'\Sekolahku <body>
Gambar 55. Klik Ikon Save pada Standard Toolbar
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H. Mengubah Ukuran Huruf
1. Klik pada tab format.css.

D ——

[Lﬁ Web Site ” im':lva}c.l'(;t \[format.c

h1

[ fo

=)

Y verdana; font-weight: bold 1

Gambar 56. Memilih tab format.css

2. Pada Menu Bar klik Format > Style

! File Edit View Insert | Format | Tools Table Data Frames
HRRN=EN" N NN A
§| v|| ﬂ :_E'.E':"E'-"- r E
Folder List -l B e | ——
) F:\My Docs\Sekolahku 2 - lBmily
[ _private T 8 Layers..
|5 images —
4 format.css -
Pa s |
4 index.htm == [~
Sivle Sheet Links L
Dynamic Web Template 3

Gambar 57. Membuat Style Baru
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3. Pada window Stile klik Modiﬁ.

Styles: Paragraph preview

Faragraph Ezing Modified Paragraph Bzing
Modified Faragraph Ezing Modifled
Faragraph Bzing Modified Paragraph Being
Modified

Character preview

AaBbYyGgll)j _ |

Description
font-family: verdana; font-weight: bold

List:
User-defined styles w |

Gambear 58. Klik Tombol Modify untuk Melanjutkan

4. Pada window Modify Style klik Format > Font
Style B3

Styles:

Modify Style

Mame (selector): Style type:
|h1 | |?3'_'-;'3:'

Preview

FParagraph E<ing Modified Faragraph Bzing Modified
Faragraph BEzing Modiflied Faragraph Bzing Modified

Faragraph Ezing ModHizd

gragh Follb wing Famgmph Folbwing Famgmph Folbwing Pamgmph

List Description
ist:

font-family; Verdana; font-weight: bold
User-

=

q/ @ l OK ] [ Cancel ]
\ Paragraph. .. [ Ok, ][ Cancel ]

Border...
Mumbering...
Position...

Gambar 59. Melakukan Format Font
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5. Pada window Font ketikkan 16pt. Klik tombol OK untuk melanjutkan.

Font E|
Font | Character Spacing
Font: Font style: /ﬁ \\
Verdana Bold 16pt
Tw Cen MT A | |Italic A‘\ 10px Y ’/
Tw Cen MT Condensed — | |Obligue — T S
Tw Cen MT Condensed Extra Bold mﬂh 2mm b
— | |BoldTtslic  — | |1em
Webdinas | |Bold Oblique | |8pt v
Color: | Automatic v |
Effects
Cunderline [ small caps
[ strikethrough [ Al caps
[ overline [ capitalize
[ elink [(Hidden
[ Mo text decoration
Preview
- AaBbYyGgLlJj _ |
e —

Q oK \[)Canoel |

Gambar 60. Memilih Ukuran Huruf 16pt

6. Klik OK
Modify Style X
Mame (selector): Style type:
ht | | |
Preview
Paragraph Being Modified Paragraph Being
Hudi%ecrparagraph Being Moditied Paragraph
Being Modified Paragraph Being Modified
Description
font-family: Verdana; font-size: 16pt; font-weight: bold
Format ¥ [ QK %J [) Cancel ]
\_/I

Gambar 61. Klik Tombol OK untuk Melanjutkan
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7. Klik OK di window Stile

Styles: Paragraph preview

Paragraph Being Modified
Paragraph Being Modified
Paragraph Being Modified

Character preview

_ AaBbYyGgLIl})j _
Description
font-family: Verdana; font-size: 16pt; font-weight:
bold
List:
User-defined styles £ |
[ MNew... ] I Maodify. .. ] [ Delete ]

Gambar 62. Klik Tombol OK untuk Melanjutkan

8. format.css akan terlihat seperti pada gambar berikut ini.

&l Web Site ” index.htm \[format.css* — —

i h1 { font-family: Vem@ht: bold; fm@ }
2

Gambar 62. Tampilan Hasil format.css

9. Kilik ikon Save.

i File # . t t Tools  Tal
id(-tﬁ-@éﬁ_s-'lmvlﬁﬁlvﬁ

= v 4

|~ |
Folder List & =

[ F:\My Docs'\Sekolahku M
I _private
) images

Gambar 6ﬂ3’ Klik Tkon Save pada Standard Toolbar

Teknologi Informasi dan Komunikasi (TIK) SMP 56 dari 93
Sekolah Bertaraf Internasional



Buku Ajar Modul 11
Perangkat Lunak Desain VWeb

10. Klik tab index.htm, maka sekarang akan kelihatan seperti gambar di
bawah ini.

L4 X ||| & web Site || index.htm* ™| format.css
lahku <body

Home page Sekolahku

Gambar 64. Tampilan Hasil format.css di Browser

I. Mengubah Ketebalan Huruf
1. Pastikan cursor berada di bagian akhir kalimat “Home page
Sekolahku”. Kemudian tekan tombol Enter untuk membuat peragraf

baru.

4

I e
~ Bl

L EB R PG R T b B S0

= Verdana - 16pt - | I u |
3 x| |[[@ web site index.htm\\l\fnrmat.css

Jocs\Sekolahku
<body

ivate
g Home page Sekolah@)
=x.hitm

Gambar 65. Penempatan cursor di Akhir Kalimat

2. Setelah membuat paragraf baru, ketik kalimat :

“Berikut ini adalah nama teman-temanku :“
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|4l Web 5ite || index.htm® ™| format.css
<body >

Home page Sekolahku

Berikut ini adalah nama teman-temanku

Gambar 66. Tampilan Hasil setelah Ada Penambahan Kalimat

3. Save halaman itu dengan mengeklik ikon Save seperti yang dijelaskan
pada bab sebelumnya.

4. Selanjutnya klik tab format.css.

(s8] Web site index.htd ‘{fnrrrmt.u:t;

format. css

Gambar 67. Posisi tab format.css

5. Pada format.css klik baris di bawah h1 untuk menempatkan cursor mouse.

[,_qj Web Site ” index.htm® \\{format.css

hl { font-family: Verdana; font-weight: bold; font-size:lépt }
T
Gambar 68. Posisi cursor di bawah h1
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6. Pada Menu Bar klik Format > Style

Format | Tools Table Data Fre
AN For
ﬁ Paragraph... I
=8 Bu bering. -
- m
Behaviors
I
Layers
|l#f| Theme
A
4o ]
Style Sheet Links... L\S
Diynamic Web Template 3
b
W

Gambar 69. Memilih Submenu Style

7. Pada window Style, klik HTML tags seperti pada gambar berikut.

Style 3

Styles: Paragraph preview

Paragraph Being Modified
Paragraph Being Modified
Paragraph Being Modified

Character preview

_ AaBbYyGgLll)j
Description
font-family: Verdana; font-weight: bold; font-size:
16pt

List:

ﬂiser-deﬁned styles $

< User-defined sies
[ MNew. .. H Modify... H Delete ]

I oK ][ Cancel ]

Gambar 70. Memilih HTML tags pada dropdown list
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8. Setelah HTML tags dipilih, klik p.

Style X]

Styles: Paragraph preview
hitml s
input B
legend

li Famgmph Boimg M odifed Pamgemph Boisg Medfed Pamgemph
Bmmg i edifed Parmgeagh Bomg M ndifed Pamgmph Baimgy

L M cdzfed
< option )
NQrE Eg | - Character preview
sl

table .
wl I AaBbYvyGgLllj _ |
textarea
th
ir Description
ul 3 Click Maodify to create a style for the currently
— | selected HTML taag.

= Click Mew to create a new custom style.
HTML tags v |

[ Mew. .. l [ Modify... ]

[ Ok ] [ Cancel

Gambar 71. Pilih Styles p

9. Klik tombol Modify untuk melanjutkan.

Style X
Styles: Paragraph preview
hitml -
input B
legend
li Famgmph Brigy M edifed Famgmph Beiny Medfed Fangegh
Bong M edifed Parsgeegh B oimg M odifed Pamgeph Boing

al Modikd
oiﬁon
pre Character preview
select
table .
f _ AaBbYyGellj _
textarea
th
ir Description
ul ¥ Click Modify to create a style for the currently

— | selected HTML tag.
Lists Click New to create a new custom style.
HTML tags v |

I QK ] [ Cancel ]
Gambear 72. Klik Tombol Modify untuk Melanjutkan
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10. Pada window Modify Style klik Format, kemudian pilih Font.

Modify Style

Mame (selector):

Style type:

li ||:|

pre
select

Preview
table
td

textal

xd ¥

pk Bong Modficd B ph Boing Medificd

d Pamgmgh Bong Med Exd

Border...

MNumbering. ..
Position...

Gambar 73. Melakukan Format Font

11. Setelah window Font muncul, pilih font Arial dan ukuran 10pt seperti

gambar di bawah ini.

Font

Font | Character Spadng |

Font:

Font style:

Mormal

Italic

Arial Narrow ¥ |Bold Italic ™

Color: | [] Automatic A |

Effects
[ underline []5mall caps
[] strikethrough [ all caps
[ overline [ capitalize
[ Blink [ Hidden
[IMo text decoration

Preview
- AaBbYyGgLL [

[ ok

J[ Cancel ]

Gambar 74. Memilih font Arial dengan ukuran 10pt
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12. Kemudian klik OK pada window Font, klik OK pada window Modify
Style, klik OK pada window Style.

13. Selanjutnya akan terlihat seperti gambar di bawah ini.

[,jj Web Site ” index.htm \[format.css*

hl { font-family: Verdana; font-weight: bold; font-size:lépt }
4] { font-family: Arial; font-size: 10pt }

Gambar 75. Tampilan Hasil format.css

14. Klik ikon Save untuk menyimpan Style Sheet.

§ @IE
e

‘older List doa x G

Gambar 76. Klik ikon Save pada Standard Toolbar

15. klik tab index.htm lalu akan terlihat seperti gambar di bawah ini.

4] Web site index.htm\kfurmat.css‘
<body >

Home page Sekolahku

Berikut ini adalah nama teman-temanku :

Gambar 77. Tampilan Hasil di Browser
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16. Highlight kata “nama teman-temanku”

[&] Web site index.htm\fnrmat.css’
<body =

Home page Sekolahku

Gambar 78. Highlight kata “nama teman-temanku”

17. Pada Formatting Toolbar klik ikon Bold.

Format Tools Table Date Frames Window

O-d 8-V e 9 - -

- mp( - | I g)%
)
index.h a =
<body =

o [dL.C55

Gambar 79. Klik ikon Bold pada Formatting Toolbar

18. Kemudian klik pada bagian yang kosong di lembar kerja untuk

menghilangkan highlight, maka tampilan akan menjadi seperti pada
gambar berikut.

4] Web site || index.htm™® ™| format.css®

Home page Sekolahku

Berikut ini adalah nama teman-temanku :

Gambar 80. Tampilan Hasil di Browser

19. Simpan halaman web dengan mengklik ikon Save
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J. Perataan Teks (Align Text)
1. Tempatkan cursor pada kalimat dengan cara mengeklik pada kalimat
yang akan diratakan.

2. Pada Formatting Toolbar klik ikon Align Right.

B S| 9 T P
3 7 U %EEI).x

z\hS/
I\fo rmat.css Align Right

Gambar 81. Klik Ikon Align Right untuk Merata Kanankan Kalimat

3. Halaman web akan berbentuk seperti di bawah ini.

(4l Web Site || index.htm* | format.css* X
<body>| <p=>

Home page Sekolahku

Berikut ini adalah nama temantemanku :

Gambar 82. Tampilan Hasil di Browser

4. Klik ikon Align Center

& S 2@ 3 [
]z @ =E[E]S) A
¥ I format.css CErter

Gambear 83. Klik Ikon Center untuk Membuat Tengah Kalimat

5. Halaman web akan terlihat seperti di bawah ini.

&l Web Site || index.htm* | format.css® x
<body>||<p>

Home page Sekolahku

Berikut ini adalah nhma teman-temanku :

Gambar 84. Tampilan Hasil di Browser
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6. Klik ikon Align Right.

ﬁw_\'JjL.

Gambar 85. Klik Ikon Align Left untuk Merata Kirikan Kalimat

7. Halaman web akan terlihat seperti di bawah ini.

&l Web Site || index.htm®* ™|_format.css®
<body>||<p>

Home page Sekolahku

Berikut ini adalah nama teman-temanku -

Gambar 86. Tampilan Hasil di Browser
8. Simpan halaman web dengan mengklik ikon Save

K. Indent Text
1. Buatlah 3 baris tulisan nama seperti di bawah ini.

Andi Supandi
Ani Widiawati

Tono Sutono

(@l Web Site || index.htm™ ™| format.css™
<body >

Home page Sekolahku

Berikut ini adalah nama teman-temanku :

Andi Supandi
Ani Widiawati

Tong Sutono

Gambar 87. Penambahan 3 Baris Tulisan
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2. Highlight ketiga baris nama yang baru dibuat.

@] Web site || index.htm®* ™| format.css™

Home page Sekolahku

Berikut ini adalah nama teman-temanku :

ndi Supandi

ni Widiawati

ono Sutono

Gambar 88. Tampilan Hasil setelah Proses Highlight

3. Kemudian klik ikon Increase Indent.

Increase Indent|

Gambar 89. Klik Ikon Increase Indent

4. Tampilan halaman akan seperti ini :

|| Web Site || index.htm®* ™| format.css*

Home page Sekolahku

Berikut ini adalah nama teman-temanku :

ndi Supandi

ni Widiawati

ono Sutono

Gambar 90. Tampilan Hasil di Browser
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5. Simpan halaman dengan mengeklik ikon Save

L. Membuat List (Daftar)
1. Highlight ketiga baris tulisan nama kemudian klik ikon Bullets.

Format Tools Table Dats Frames Window Help

DS 8 -V & @ J 9 -

- pt -~/ B I U |
4] Web Site index.htm\\kfnrmat.css

Home page Sekolahku

Berikut ini adalah nama teman-temanku :

ndi Supandi

ni Widiawati

ono Sutono

Gambar 91. Klik Ikon Bullets pada Formatting Toolbar

2. Tampilan halaman web akan menjadi seperti dibawah ini.

|| Web Site || index.htm®* ™| format.css

Home page Sekolahku

Berikut ini adalah nama teman-temanku :

* fndi Supandi
« Ani Widiawati
* Tong Sutono

Gambar 92. Tampilan Hasil di Browser

3. Simpan halaman dengan mengklik ikon Save
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M. Membuat Link ke Halaman Baru
1. Buatlah sebuah halaman web baru, lalu pada Standard Toolbar klik ikon

New.
it WView Insert Format Tools

S ) 3 2 F- | D

e R 1111 -
: Create a new normal page lﬂi
Folder List 0 x (s8] Web Site

I =0 T B L PAER T P B S P

Gambar 93. Klik Ikon New pada Standard Toolbar

2. Tutup (close) Layout Tables and Cells pane jika terbuka.

=D,

T

Cell Formatting

Gambar 94. Klik Tombol Close untuk Menutup

3. Klik kanan di tempat kosong pada halaman web baru, kemudian klik
Page Properties.

[,jj Web Site ” index.htm -\kfnrmat.css\{ new_page_1.htm

(7% Paste

Open Page in New Window

74 Manage Editable Regions...

| Page Properties... Py
iy
A | Font...
& Hyperlink. ..

Gambar 95. Memilih Submenu Page Properties

Teknologi Informasi dan Komunikasi (TIK) SMP 68 dari 93
Sekolah Bertaraf Internasional



Buku Ajar Modul 11
Perangkat Lunak Desain Web

4. Pada Title masukkan Halaman Andi.

Page Properties

General |Forrnath'ng || Advanced || Custom || Language || Warkaroup |

Location:

Title:

Location:

Loop:

Page description:

Keywords:

Base location:

Background sound

nsaved://ewpage_L.htm |

|Halaman andi ) |

\_/’

Default target frame: |

I:l Forever

[ OK ] [ Cancel

5. Kemudian klik OK

Gambar 96. Mengisi Title

6. Simpan halaman web baru dengan mengeklik ikon Save.

7. Ketika window Save As muncul, pada File name ketik andi.htm

Save As

Save in: | Sekolahku V| @ - '& X i Ef - Toos~
_ &] _private
& (Cimages
My Recent || format. css
Documents Lijindex.hh'n
&
Desktop
( iy
I'I
My Documents
3
My Computer
e
[l File n v|
My Metwork
Flaces Save a
Gambar 97. Mengisi File Name
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8. Kilik Save.
Save As @
Save jn: | Sekolahku Vl @ - O | Q X 4 3 - Toos~
L3 _private
& (Chimages
My Recent L. format.css
Documents Ifj index.htm
r_[l ::"i
Desktop
Fat
My Documents
w3
My Computer
~ Page title: Halaman Andi
File name:  [and.htm o @ r\,l
My Metwork —
Places Save as type: |Web Pages (*.htm; *.html;*.shtml;*.shtm; *.stm; *.asp; = ¥ | Cancel
—

Gambar 98. Klik Tombol Save untuk Menyimpan

Nama sebuah file dalam website yang baik adalah
nama file tanpa spasi dan semua hurufnya lowercase
(huruf kecil)

9. Ketik kalimat berikut.
“Ini adalah halaman Andi Supandi”

[|_ﬂ Web Site ” index.htm \\kfnrmat.css\[andi.htm*

Ini adalah halaman Andi Supandi

Gambar 99. Mengetik Kalimat
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10. Pada Menu Bar klik Format > Style Sheet Links

Format | Tools Table Data Frames

Fant... f |

Faragrapn... Ir H
Bullets and Numbering. ..

[| 3=

Behayiors. ..

Layers... —

Theme... Indi

Style...

| Style Sheet Links... D@_‘
Dynamic Web Template 3

%

I (& 1F

Gambar 100. Memilih Submenu Style Sheet Links

11. Pada window Link Style Sheet klik Add.

Link Style Sheet

() All pages

(%) Selected page(s) /
URL: K Add... >

[ OK l[ Cancel ]

Gambar 101. Klik Tombol Add untuk Menambah
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12. Pada window Select Style Sheet klik format.css.

Select Style Sheet

Lookin: | 8 F:\My Docs\Sekolahku v =
Mame Title
format.css
< |
URL: |format.css 7 | g 5|

Gambar 102. Klik format.css

13. Kemudian klik OK, halaman web yang baru dibuat telah tersambung
dengan Style Sheet website, format.css.

14. Simpan halaman andi.htm dengan mengeklik ikon Save.

15. Klik tab format.css. Kemudian klik pada sebelah bawah p untuk

menempatkan cursor.
|l web site || indﬂ.htm@ ndi.htm*

<body =

format.css

Ini adalah halaman Andi Supandi

Gambar 103. Klik tab format.css

[Lﬂ Web Site ” index.htm \{format.css\\kandi.htm*

[ font-family: Verdana; font-weight: bold; font-size:lépt 1}
¢ { font-family: Arial:; font-size: 10pt }

Gambar 104. Posisi cursor pada tab format.css
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16. Pada Menu Bar klik Format, kemudian Style.

WI Tools Table Data Fr:
AN Fon

Sll Paragrap .
= Bullzts and Mumbering. -
B he

Behaviors
=8
LAyers -

s} Theme

Y
!-:.%-?

Style Sheet Links... ['E

Dynamic Web Template 3

¥

Gambear 105. Memilih Submenu Style

17. Pada window Style, klik bagian List, pilih HTML tags, kemudian pilih
style h2.

Style X

Styles: Paragraph preview

i@:active S

ahover 3

a:link

arvisited Famgmph Being Medifed Fangmgh Being Modded Pamgmgh
Boing M cdifed Farsgragh B oing M odifed Famgmgh Baisg

a M cdzid

address

body

button Character preview

Thi n
C

— e —
Tha

hs Description
h& Z Click Modify to create a style for the currently
br Y| selected HTML tag.

Click Mew to create a new custom style,

< |I-|'I'I'~'1L1ﬁgs vl)
P — ___—

[ Mew. .. H Modify... ]

[ Ok, ] [ Cancel

Gambar 106. Memilih Style h2
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18. Klik Modify.

HTML tags w
| |

[ 0K ] [ Cancel

Gambar 107. Klik Tombol Modify untuk Melanjutkan

19. Pada window Modify Style klik Format, kemudian Font.

Modify Style 3

Name (selector): Style type:

h2 || |

Preview

= dfzd Pamgmpk Bong Med Sod Peapaph Bong Madificd
2 Pamgmgh Boing Med S=d

Description

Paragraph. . !

ar

Mumbering...
Position...

Gambar 108. Melakukan Format Font
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20. Pada window Font, klik Verdana, kemudian pilih 14pt.

Font E

Font | Character Spacing
Font: Fant style: -
Verdana Marmal 1401} ‘)
A Lot/
Webdings — | |Italic E
e Oblique
Wingdings 2 —'| | Bold = 13pt
Wingdings 3 ¥ |Bold Italic ™ 24pt bl
Color: ‘ Automatic " ‘
Effects
[Junderline [ small caps
[ strikethrough [Jall caps
[Joverline [ capitalize
[ ]Blink [ Hidden
[IMo text decoration
Preview
AaBbYyGgLlJj
[ 0K ] [ Cancel ]

Gambar 109. Memilih Font Verdana dengan Ukuran 14pt

21. Klik OK pada window Font, window Modify Style, window Style
format.css akan terlihat seperti gambar di bawah ini.

[Lﬁ Web Site ” index.htm ‘\{format.css*-\kandi.htm*

hl [ font-family: Verdana; font-weight: bold; font-size:lépt }
B { font-family: Arial; font-size: 1l0pt 1}
h2 { font-family: Verdana; font-size: 1l4pt }

Gambar 110. Tampilan Hasil format.css

22. Simpan format.css dengan mengeklik ikon save
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23. Klik tab andi.htm.

[.jj Web Site ” index.htm -\kfnrmat.css*-\[ andi.htg

bod

Ini adalah halaman Andi Supandi

Gambar 111. Memilih tab andi.htm

24. Tempatkan cursor di baris pertama, kemudian klik Heading 2 pada Style

list.
! Fle Edit WView Insert Format Tools Table Data Frames  Window Help
R RA=R" N NN RN NCe e A EENG - A RN R - N
ENormaI = | Arial + 10pt le I g|§§§§|
| 7 Address

1 Bulleted List [,jj Web Site ” index.htm \fnrmat.css*\[ andi.htm

8 Default Character Style
T Defined Term <body>

T Definition

11 Directory List : : g
| Lprometies ———| | " adalah halaman Andi Supand]
1 Heading 1 >

T Heading 3 k
T Heading 5
T Heading 6
1 Menu List

T Mormal
T Mumbered List

Gambar 112. Memilih Heading 2 pada Style List

25. Halaman web akan terlihat seperti dibawah ini.
EHeadingZ ~ Verdana - 14pt - | I U | =

Falder List 03 x [l_uj Web site ” index.htm \kfnrmat.css*\[andi.htm*
(5 F:\My Docs\Sekolahlku <body>| [<hz>
I _private
| images - - .
% format.css Ini adalah halaman Andi Supandi
ﬁ index.htm
% andi.htm

il
[
e
-
1
|
I
|

Gambar 113. Tampilan Hasil di Browser

26. Simpan halaman web dengan mengklik ikon Save

Teknologi Informasi dan Komunikasi (TIK) SMP 76 dari 93
Sekolah Bertaraf Internasional



Buku Ajar Modul 11
Perangkat Lunak Desain VWeb

N. Membuat Link Antar Halaman
1. Klik tab index.htm.

2. Highlight pada tulisan “Andi Supandi”.

(sl Web site index.htm\\kfnrmat.css*\kandi.htm*

<body = | |<blockquote | |<ul=| [<li=

Home page Sekolahku

Berikut ini adalah nama teman-temanku :

* Tong Sutono

Gambear 114. Highlight Tulisan

3. Pada Standard Toolbar klik ikon Insert Hyperlink.

Help
4@:@@w Lo

A v — 19& 3 i ab# A
LA A rIink —

.htm*

Gambar 115. Klik Ikon Insert Hyperlink pada Standard Toolbar

4. Pada window Insert Hyperlink, klik andi.

Insert Hyperlink

Link to: Text to display: |Andi Supandi | ScreenTip...

Look in: | Sekolahku v|
S

Existing File or

i

Web Page |2] index.htm (open) Bookmark...
CH"I;E”t | _private
XL ) vi_enf Target Frame. ..
Place in This - i _pvt
Document Brow images Parameters...
Pafies =
;iﬁ [ Style...
Create Mew Recent =
Document Files \f] index -,
v
Address: |andi.htrn b |
E-mail Address
[ oK l [ Cancel
Gambar 116. Memilih File dengan nama andi
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5. Kemudian klik OK.

6. Klik pada halaman web untuk menghilangkan highlight, dan tampilan
halaman web akan terlihat seperti dibawah dan Andi Supandi telah
menjadi sebuah [link ditandai dengan adanya garis bawah dan
perubahan cursor mouse saat melewati tulisan Andi Supandi.

(&3] Web site index.htm*\kfnrmat.css-\kandi.htm

Home page Sekolahku

Berikut ini adalah nama teman-temanku :

* Andi Supandi
&ni Widigyat
* Tone Sutono

Gambar 117. Hasil Penambahan Fasilitas Hyperlink
7. Simpan halaman web dengan mengklik ikon Save.

8. Pada Standard Toolbar klik ikon Preview.

View Insert Form, ToO shle Data Frames Window Help
= =1 BN A Fe e Ay R N W=
g

= Times Mew Rﬂmanwmosoﬁ Internet Explorer ?.D'E = | A
Gambar 118. Klik Ikon Preview untuk Melihat Hasil
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9. Browser akan terbuka dan dapat dilihat tampilan halaman web yang kita
buat di browser.

£= Home page Sekolahku - Windows Internet Explorer

:‘-. - |@F:\My Docs'\sekolahkuljndex. htm V| 41X ‘ | P~

s T

w ke [@Home page Sekolahku l_l - B e v [2hPage v () Tools - »

Home page Sekolahku

Berikut ini adalah nama teman-temanku :

« Andi Supandi

« Ani Widiawati

« Tono Sutono

' My Computer #100% -~

Gambar 119. Tampilan Hasil di Browser Internet Explorer

10. Klik Andi Supandi yang telah menjadi link.

= Home page Sekolahku - Windows Internet Explorer

iy . [gR . -
(/) v | @ Fi\my Docs\sekolshkulndex.hem v

f:i' "1”}? [ @ Home page Sekalahku ]_‘

Home page Sekolahku

Berikut ini adalah nama teman-temanku

» Andi Supandi

o Ani Widiawati

+ Tono Sutono

Gambar 120. Posisi cursor mouse saat melewati Link
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11. Maka halaman web andi.htm akan terbuka.

f.; Halaman Andi - Windows Internet Explorer

@; ~ | & Fiy Docsisekolahkutand him | [4#][x] | |[2]-

w '{R? [@Halaman Andi lil &B- B o - [ Page v {3 Tooks ~ >

Ini adalah halaman Andi Supandi

Done :} My Computer H 100% v

Gambear 121. Tampilan Hasil di Browser

12. Untuk menutup browser, klik tombol x pada window.

ﬂ; Halaman Andi - Windows Internet Explorer

@.\_/-. ~ | @ F:y Docs Sekolahiu\andi him | [#2] [x] |
I - »

w e I@Halaman Andi l l & - B deh - [5F Page  {F Tools ~

Ini adalah halaman Andi Supandi

Done :-} My Computer * 100% T

Gambar 122. Menutup Browser
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13. Buatlah halaman web untuk Ani Widiawati dan Tono Sutono, untuk
lebih mudahnya bukalah halaman web Andi Supandi kemudian Save As
sebagai halaman lain.

14. Kemudian klik tab andi.htm.

[._gj Web Site H index.htm \furmatm Em

<body=
Halaman Andi

Ini adalah halaman Andi Supandi

Gambar 123. Memilih tab andi.htm

15. Pada Menu Bar, klik File > Save As

| File | Edit View Insert f
N T =
j ) e e
;| [ Open.. Ctrl+0
8 Close e
L 0 Site _E
i 1= pen Site...
Close Site —
& save Cirl45 .
| Save As... [
%1 File Search...

Gambar 124. Memilih Submenu Save As
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16. Pada window Save As masukkan nama file ani.htm, kemudian klik
Change Title.

savein: | (@] sekolahku v| @ @@ X i & - ook~
_, () _private
"€ [Eaimages
My Recent andi
Documents ? format
@ index
|4
Desktop
I
My Documents
My Computer B ——
C
u T[]
My Metwork
Places v| Cancel
“ |

Gambar 125. Mengganti Nama File

17. Masukkan Halaman Ani pada window Set Page Title, kemudian tekan

OK.
Save As li”il
Save in: | Sekolahku v | @ - | @ X iy EF - Tods~
] I3 _private
L [)images
My Recent &) andi .
Eroora % format Set Page Title el
index m
@ < |Halaman A ) |
Desktop Me iz displayed in the title bar of the
browser.
rl" ¥ [ oK D Cancel ]
My Documents I =
My Computer
Page title: Halaman Andi
E a Filename:  [ani.htm vl [ save |
My Metwork =
Flaces Save as type: |Web Pages w | Cancel p

Gambear 126. Mengganti Title Halaman
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18. Tekan Save.

Save As
Save in: | Sekolahku V| @ @A '& XA [ 2 ~ Took~
) 2 _private
[ ICTimages
My Recent L"ﬂ andi
Documents . format
= |&]index
I I_f. i
Desktop
My Documents
My Computer
- Page title: Halaman Ani Change title...
Eg File name: |ar1i.htrn ~ |
My Metwark
Flaces Save as type: |Web Pages b |

Gambear 127. Klik Tombol Save untuk Menyimpan

19. Setelah Save diklik, secara otomatis halaman web andi.htm yang tadi
terbuka di FrontPage tertutup dan digantikan oleh ani.htm.

[li Web Site ” index.htm \kfnrmat.c(s\{/anm
\/

<body =

Ini adalah halaman Andi Supandi

Gambar 128. Tampilan pada tab ani.htm

20. Karena isi halaman web andi.htm dan ani.htm masih sama, editlah
halaman web ani.htm.
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21. Ganti tulisan menjadi “Ini adalah halaman Ani Widiawati”.

[,_ﬂj Web Site ” index.htm \fnrmat.css-\[ani.htm*

<body =

Ini adalah halaman Ani Wi@

Gambar 129. Tampilan Setelah Penggantian Tulisan

22. Simpan halaman ani.htm dengan menekan ikon Save.

23. Klik tab index.htm dan buatlah link dari halaman index.htm menuju
halaman ani.htm pada nama Ani Widiawati.

|&] Web Site index.htm\\kfnrmat.css\kani.htm‘

<body=| |<blockquote = | |<ul= <li=

Home page Sekolahku

Berikut ini adalah nama teman-temanku :

* Andi Supandi
* &mWidiawatM/

* Tong Sutono

Gambar 130. Membuat Link pada Tulisan “Ani Widiawati”

24. Lakukan langkah-langkah yang sama untuk membuat halaman untuk
Tono Sutono. Lakukan Save As halaman ani.htm dan berikan nama
tono.htm, ganti Title menjadi Halaman Tono, kemudian edit tulisan
dalam halaman tono.htm menjadi “Ini adalah halaman Tono Sutono”.
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[,_ﬂj Web Site ” index.htm \\kfnrmat.css\[tono.htm*

<body =

Ini adalah halaman Tono Sutono|

Gambar 131. Tampilan Setelah Proses Pembuatan Halaman Baru
25. Simpan halaman web dengan mengklik ikon Save.
26. Buatlah [link dari index.htm menuju halaman tono.htm pada Tono

Sutono, sehingga tampilan halaman index.htm menjadi seperti di
bawah ini.

(&l Web Site index.htm*\format.css-\ktnnn.htm

<body>| [<blodquote>| |<ul=| <= |<p>

Home page Sekolahku

Berikut ini adalah nama teman-temanku :

* Andi Supandi
* Ani Widiawa
* Tono Sutono

Gambar 132. Tampilan Setelah Proses Pembuatan Link
27. Simpan halaman dengan mengeklik ikon Save.

28. Klik ikon Preview untuk mencoba melihat tampilan halaman web di
browser.

Data Frames W
@B 7|9
im rlumllz

Preview in Microsoft Internet Explo

|l Web 5ite || index.htm® -] format.css

<body > |<blockquote>| <ul> <li= <p= E

Gambar 133. Klik Ikon Preview untuk Melihat Hasil d Browser
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29. Tampilan di browser adalah seperti gambar di bawah ini. Cobalah klik
link-link yang ada di halaman web.

{= Home page Sekolahku - Windows Internet Explorer

o

W e [@Home page Sekolahku l_l 3-8 e - |k Page - {0} Tools - >

Home page Sekolahku

Berikut ini adalah nama teman-temanku :

» Andi Supandi /
e Ani Wldlawatl/

+ Tono Sutono /

4 My Computer H100% v

Gambear 134. Link-Link yang Mempunyai Pertautan Halaman

30. Setelah link diklik akan muncul halaman web yang baru, tekan ikon Back
untuk kembali ke home page.

= Halan.an Ani - Windows Internet Explorer

o & |@F:\My Docs'Sekolahkuani.htm v| || X | | ol
— — " 3>
Home page Sekolahku (AltH eft) ] ] % v B - deh v [=hPage v i) Todls ~

Ini adalah halaman Ani Widiawati

Done 4 My Computer H100% +

Gambar 135. Klik Ikon Back untuk Kembali
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O. Memasukkan Gambar

1. Letakkan cursor mouse seperti pada gambar berikut.

(&3] Web site index.htm\kformat.css\tnnn.htm
<body >

Home page Sekolahku

Berikut ini adalah nama teman-temanku :

* Andi Supandi

* Ani Widiawati
/ * Tono Sutono

Gambar 136. Posisi cursor mouse

2. Klik ikon Insert Picture From File.

Frames Window Hel

B9 - -vu@glﬂ 2T
L @l |—'wmreﬁnmﬁle =

‘orm at.css\ktnnn.htm

=]

Gambar 137. Klik Ikon Insert Picture From File

3. Carilah gambar di komputer, kemudian klik sekali pada gambar dan
tekan Insert.

Picture E]
Look in: |@ nst_forums_data v| S - Q X L [E = Tools -
.3;3,

My Recent

Documents

My Documents

My Cnmputer
- /! N

E ; File name: | - ‘ [ Ingert, |*
My Network —
Places Files of type: |A|I Pictures

v ‘ Cancel

Gambar 138. Klik Tombol Insert untuk Menyisipkan Gambar
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4. Tampilan index.htm akan menjadi seperti di bawah ini.

4] Web site index.htm*\kfnrmat.css-\ktnnn.htm
<body >

Home page Sekolahku

Berikut ini adalah nama teman-temanku :

* Andi Supandi
= Ani Widiawati
* Tono Sutono

Which one will you choose?

=5:BIECKEEW}F Click to explore more >

Gambar 139. Tampilan Hasil di Browser

5. Simpan halaman web dengan mengklik ikon Save.
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6. Sehingga akan muncul window Save Embedded Files, klik Change Folder.

Save Embedded Files

Embedded files to save: Picture preview:

MName Folder Action

 lponsel.ipg save

BB EackBeny. Gl i s

Change Folfer. " Set Action... [ Picture File Type... ]

[ 0K ][ Cancel ]

Gambar 140. Klik Tombol Change Folder

7. Lakukan double klik pada folder images.

nge Folder
Loaok in: | Fi\My Docs'\Sekolahku " i
Title
+ |3
[ OK ] [ Cancel ]

Gambar 141. Double Klik pada Folder Images
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8. Setelah folder images terbuka, klik OK.

Change Folder

Look in: |E} images

Mame

|

Title

[ >

AN
w)cm |

Gambar 142. Klik Tombol OK untuk Melanjutkan

9. Kemudian pada window Save Embedded Files klik OK.

Save Embedded Files

Embedded files to save:

MNarme

[ lponsel.ipg

Folder

images/

[Change Folder.. ]

Picture preview:

Action
Save

L]

BB fackBemry. (il beakiaay »

| set Action... | | Picture File Type... |

m Cancel ]
L Z

Gambar 143. Klik Tombol OK untuk Melanjutkan
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20. Maka gambar tadi secara otomatis akan disalin ke folder/direktori
website.

10. Klik pada tanda + folder images untuk melihat apakah gambar sudah
disalin (copy) atau belum.

MET=2R" I NN PR RER- AP =W
] | | LB

Folder List 1 [ x| [[@ web site || index.htm | forma

) FsWy Docs\Sekolahiu <body>

|5y _priva
[ }images
(525D Home page sek

index. htm

5] andi.htm Berikut ini adalah nama teman:
[=5] ani.htm
% tono.him * Andi Supandi

* Ani Widiawati

* Tono Sutono

Gambar 144. Klik Tanda + untuk Melihat Isi Folder

11. Setelah tanda + diklik terlihat gambar sudah disalin.

@ ponsel.jpa

Gambear 145. Isi dari Folder Images

12. Simpan halaman dengan mengklik ikon Save.
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13. Klik ikon Preview untuk mengetahui tampilan halaman web di browser.

14. Tampilan halaman web di browser akan tampak seperti gambar di bawah
ini.

{= Home page Sekolahku - Windows Internet Explorer

.;__—}. .\-__}. - |@ F:\My Docs\Sekolahkuljndex.htm

W [ (& Home page Sekolahku l_l

- 8 sy - |2k Page + {f Tools + »

Home page Sekolahku
Berikut ini adalah nama teman-temanku :

« Andi Supandi

« Ani Widiawati

e Tono Sutono

Which one will you choose?

=

=2r BlackBerry. Click to explore more >

4 My Computer #100% -

Gambar 146. Tampilan Hasil Halaman Web di Browser
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